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Legal Disclaimer

While | am very much a Google devotee, | am in no way associated or employed by
Google, Inc. or any of its subsidiaries. This book has not been endorsed by Google or
any of their employees.

The information in this book is just a guide for people on the go who want to improve
their communication, productivity and marketing activities using mobile devices and
cloud computing apps. | cannot guarantee that you will get as much from this as | do,
but as a business traveler who relies on my office in my pocket, | can speak to its
effectiveness and endorse its capabilities.

Google, it's logo and graphic representations of all Google products are all trademarks
of Google, Incorporated. | claim no rights to their properties, process or available
technologies.

Keywords Are the Secret Sauce of Google

When you type in a search query in Google or other search engines, it uses the terms you
add to make a search of its database of websites that contain the words you typed. The
closer the exact match of the websites keywords to the search query determines which sites
populate at the top of the list. There will be several opportunities for us to use keywords to
make your content discoverable and increase your market to a global scale.

Secrets of Gmail
Let’s begin with signing into your Gmail account.

Once you've signed in, click onto the gear icon in the upper right corner and select Settings.
Here we will customize the Gmail experience. Before we go there, let's take a look at some
of the latest features of Gmail: If you haven't yet created an account, Go to
www.Gmail.com and do so.

Google Gmail EI

Gmail Features and Benefits

=Generous (15GB) mailbox

=Simple to organize

=Flexible and transparent

=Easy to set up on mobile devices

=account Interoperability with Microsoft Outlook email and calendar
=Mobile email, calendar and IM access

=Gmail contacts compatible with many applications

=An IMAP server for mobile use

=Converge all your email accounts to one Gmail account

=Telephone and videoconferencing functions




With Gmall, the ultimate mobile office starts here.
Once you've opened your Gmail, let’s take a look at your inbox.

Your Gmail inbox is a most powerful tool for sending, receiving and managing your email,
including those from multiple accounts. Having one place to open and manage your email is
a major time saver and helps to keep the flow of information more organized. Whether
you're on your iPhone or iPad, Android device or Blackberry, you will always have the same
email in the same organized place, along with synchronized contacts and calendar events
too. The secret to success is to go through the simple steps of customizing your Gmail
through settings.

Does Gmail have the space to accommodate my Gmail and other incoming mail too? Yes!
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From your inbox, look to the right where you see the Google logo. Just below is the word
Gmail and a small arrow to the right. Click the arrow and select Contacts. We will begin by
importing and organizing your contacts:

It All Begins With Your CRM

Your CRM or Client Relationship Management System is essential to the success of your
business and the best use of these Google apps. Fortune 300 companies spend hundreds
of thousands of dollars to compile and maintain their CRM databases, and for good reason:
it is simply the easiest and most effective way to develop customer profiles, target their
customer base, and to ensure customer satisfaction and retention. As small business
owners we can use tools like Microsoft Outlook, ACT!, Top Producer or other Personal
Information Management (PIM) systems as our CRM. Now that we are moving our business
to a more mobile arena, and we can use the cloud

To maintain this information, it's time to learn how to put your CRM on the cloud, using
Google Contacts, a part of Gmail:

Exporting your CRM to Google Contacts

Regardless of the PIM you currently use, the process of exporting your contacts and
importing the data into Google Contacts is relatively easy, if you follow the steps, you'll have
your contacts copied over in no time.




Step One: Prepare your CRM data

Since this information is the life blood of your business, it is important that we have each
contact profile as complete and organized as possible. Take the time to go through each
item, fill in as many empty spaces as possible. Make sure you have at least the five
essentials- full name, mailing address, email address, office & mobile phone and birth date
stored under notes.

Productivity Tip: The Three Steps To Building Your CRM
Step One: Start with what you already have

* Go through each of your contacts, looking for empty spaces
e Fill those gaps as much as possible, with a focus on future marketing

Step Two: Customize, categorize and downsize

* Create custom categories, and identify who goes where
»  Place contacts in multiple categories if possible
e Delete or archive contact information you no longer need or use

Step Three: Back up your data and share it on the cloud
*  Export your entire database and save it on an external disk
e Export and copy your data into Gmail or another online PIM system
e Store a copy in an online file storage server- it can easily be shared from here
» Set a weekly date for backing up and renewing stored data

(yes, birth date!) If you can, add anniversary dates, and other demographic information that
be can be used for staying connected.

Step Two: Assign all profiles into at least one category

Assigning a profile into one or more categories will be useful to your marketing efforts
moving forward, as well as allowing the Google apps to target specific markets for you.
Missing this step will cause you lots of work in the future.

Step Three: Export your CRM data into afile

The easiest way to get your data into Google Contacts and have it organized from the outset
is to export the contacts one category at a time. Sort your contacts by category, then

Highlight the group you intend to export. The example below is how to export from Microsoft
Outlook 2007:




Select File > Import and Export
Select Export To A File
Select Comma Separated Values (Windows)
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Save to a location on the computer, and name the file the same as the category you are

importing.

B S0t Wew G r———
hdbien - B X EY B
compary

ERRERRRE

Mavigation Pane

Buisrs rean]

adam buah

o
W Py

il 21

# Founa Cal e

Eusnass Prane

0w
70 3104820

Business Fax

Home preae

= sibome Biaress
- P p—
= Asnyer
o) A snyder
asnyoer
v} Aaar Mahamed Pime €.

tipress, Avbome
arran aiines
41 Seylr
soder

A1kt Mahaed Fims Coram

05 203 9533

[T
040664 60 [1

ammsos 0

s
=
TIOADS6MS G [

1 @0 4544

sz 20

M 0

gz o

o281 [

mase 0
w0

AEEREEREEREE R

soumal | categon =

rar

@ o

i g pan

w Go Ioals

s - 83

|44 Contacts

D 0 ui Hame.
e i 8 e

6 6 vman e

lad M Founa Callbin

] it Gate

eazs ensan
A sy

Mavigation Pane

- B EEEEEEEEEE
FEEEE

Ade testa
AGEI4 CPBAE SIS P4 A,
i

Aida Sainthits

airsome Bipress

s zooni e
HY @ w -
<ompary Butmessone  Bsmenfax  Home frone

s sames 7o) s1mm

I Found Cal il 70 2100930

Save evpuried e ac

i, ians Deshinas

ssco

Letm spariie

e =

1900 4684411

TI02148250, 700

[IEeet)

2002478726

7135047900
049832750
]

=
B
5
r

=

Fls

Categor &)

@ aie

2i5a nems

VERY IMPORTANT: Mapping the custom fields will assure that the data you export will
be the complete contact profile when you import it into Google contacts.
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In Outlook, simply drag from the left box what you want to include in the export box on the right.
Other systems will have similar options for you to customize which data fields you are exporting.
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Now, you are ready to import the data into Gmail contacts.

Step Four: Import your CRM data into Google Contacts

aint

Following the steps described above, import your contacts into Google one category at

a time, so they will be organized at the outset.

organized, and the Google apps will be able to better target your communication.

This will have your contacts better




How to export your CRM to Google Contacts from your contact database

Regardless of the PIM you currently use, the process of exporting your contacts and
importing the data into Google Contacts is relatively easy, if you follow the steps, you'll have
your contacts copied over in no time. In this case we will use Microsoft Outlook. CTRL +
Click these links to learn to export from other databases:

Export Actl to a CSV  Export Top Producer to a CSV Export Blackberry to a CSV

Export Yahoo! to a CSV Export Mac Contacts to a CSV  Export from Outlook 2010

Export Hotmail to a CSV  Export from Outlook 2007  Export Verizon backup Assistant

A Tip: It may be easier to create a CSV file for your entire contact list, then clean it up in
Microsoft Excel as a spreadsheet. Sort by any column, see which fields need to be
filed as a whole list. Add a column for Categories, sort by that field and make
separate CSV files for each category. Your data is now ready for import. Make sure
that the top row of the columns describe the field they will be assigned (ie “Name”).

Import your CRM data from Mac Computers

Click which group of contacts or the individual contact you want to export from your
Address Book on your Mac (e.g. "All Contacts" or "John Doe"). From the File menu
select Export. Click "Export Group vCard" or "Export vCard" depending on whether you
are exporting a group of contacts or just a single contact. Save vCard file to a known
location.

From Gmail click "Contacts". Click the "Import" link on the right side of the screen.
Click "Browse" and find the location of the vCard file you saved above. Click the
“Import" button.

Note: Macs do not use CSV files, and you don't need to use conversion software, as
mentioned in other posts. Import/Export on a Mac using vCard files.

The Google Contacts Preview Screen

Gmail has updated to a new Contacts Preview page with a new look and a new
interface. Adding and searching for contracts are as easy as ever, and there are a few
new features that add convenience.
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Now you are in the original Google Contacts interface, which | believe may be easier to use
for importing contacts.




It may take a while to get your contact database completely updates, sorted and then
imported into Google, but it will be well worth the effort. This is all about making your
information available to your mobile devices securely, conveniently and with an almost
instant synchronization.

Organizing Your CRM

If you followed the steps above, and you imported your groups in one at a time, you now
have them already assigned to groups. If you did not, or if your
Google in need organizing, let’s take a look at the Contacts system:

contacts are already in

Google

Contacts

NEW CONTACT

- My Contacts (93)
Starred
Active
Friends
Hot List
Imported 2/19/15 (93)
Imported 5/5/14
Leads

» Circles

Most Centacted (3)

CITACTS 10

New Group.
Import Contacts.
Try Contacts preview

it More

Adrain Andrews Adrain Andrews

Alex Alex

Al der Almira Al der Al...

aandrews@firmamentsclutions.

alexander. amullins@gmail.com

irai@aol.com

Alicia Moorehead Alicia Moore...

Amanda Heard Amanda Heard

Angela Washington Angela W...

Anita Shropshire Anita Shrops...

Anthony Burroughs Anthony ...

Anthony Hamilton Anthony Ha...

Asecret Taylor Asecret Taylor

Becky Stall Becky Stall

Bernice Royal Bernice Royal

Bertha Robinson Bertha Robin...

Atmeorehead@hctmail.com

amanda1983@bellsouth. net

Aah3161@yahoo.com

deja54@hotmail.com

burroughsantheny@ymail.com

amhamilton71@yahoo.com

ataylor128@yahoo.com

rmrs73@gmail com

bemB78%@gmail com

bertharob37 @gmail.com

Adrain - Zira

We will begin with a tour of contacts. Across the top is a search engine by which you can
look for any key word that may exist within a contact, such as a state. Below is the menu
bar. To the right of each contact entry is a blue box indicating the group(s) the contact is in.
Looking to the left panel is where the groups are organized.

To begin organizing contacts, lets create groups by clicking New Group.

MNew group

Please enter a new group name.

Cancel
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Enter the names of all your groups at once to save time. You can add, delete or rename
them at any time.

If you need to import any CSV files into contacts, begin by clicking Import Contacts. These
CSV files are the ones you created from your original contacts using the steps above. MAC
users may also import VVcards saved from Apple contacts.

Import contacts

We support importing T3V files from Cutlock, Outlock Express, Yahoo! Mail,
Hotmail, Eudera and some other apps. We also suppert importing vCard frem
apps like Apple Address Book. Learmn more

Please select a CSV or vCard file to upload:
Cheose File | Me file chosen

Select a file you've saved and click Import. The list will then populate as a new group named
today’s date.

To move the newly imported contacts to the group you have prepared for them, simply
select the group, the click the top checkbox to select the entire list. Now select Groups from
the menu icons that appear. From the dropdown menu, uncheck the box of the group they
are in (Imported today’s date) and select from the list the group(s) you wish to assign them.
Press Apply at the bottom of the menu.

If you need to create a new group at that time, select Create new.

This process will only select up to 250 contacts at one time, so if the list you imported is
more than 250, you will have to repeat the process again until all contacts have been
removed from the Imported group.

Repeat this step for as many CSV files you have created to import.
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Contacts il =t a2 More

NEW CONTACT o

= My Contacts (93)

mnentsolutions. ..
+ My Contacts

Alex Alex ¥/ Imported 2/19/15 s@gmail.com

Active
Starred Alexander Aln ) jacl.com
Friends
Active )
Alicia Mooreh Hot List otmail.com
Friends -
Imported 5/5/14
v Amanda Hear Hlsouth.net
Leads
Imported 2/19/15 (33)
v Angela Washi Create new .com
Imperted 5/5/14 reate new
v Anita Shropshire Anita Shrops... dejaS4@hotmail.com
» Circles v Anthony Burroughs Anthony ... burroughsanthony@ymail.com

\Most Contacted (3)

The next step is to locate and merge any duplicate contacts that have populated. Begin by
selecting More from the menu bar, and clicking Find and merge duplicates.

ol aF ] More ‘

Merge contacts

vl Adrain Andrews Adrain Andrews aant
Delete contacts
vl Alex Alex alex
Import...
v Alexander Almira Alexander Al...  alex Export...
Print...
v Alicia Moorehead Alicia Moore...  Atm ) )
Find & merge duplicates. ..
vl Amanda Heard Amanda Heard ama Restore contacts...
vl Angela Washington Angela W...  Aah
" First Mame
' Anita Shropshire Anita Shrops... deja Last Name
vl Anthony Burroughs Anthony ... burrcughsantheny@ymail.com

This will find all exact duplicate contacts and give you the option to merge them. They will
maintain the multiple groups they are in if merged.

Any duplicate contacts that remain after that are not exact duplicates, and therefore can be
merged manually. Select the contacts, click More and then Merge contacts.
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Note here that in the More menu you also have the options to Import and Export contacts,
print a list, or an individual contact, even restore up to 30 days and undo any changes you
have made to a group or an item.

You have now created your CRM and imported it into Gmail. This will allow you to use your
organized contacts as your mobile phone database, Google Voice custom messaging,
group emailing in Gmail, invitations and notifications in Google Calendar and much more. It
will sync to all of your connected devices and give you far more mobile access than ever
before.

Now you’re all set to begin customizing your Gmail account. Go now to the Gmail inbox and
we’ll take a look at the inbox screen.

Across the top you'll find your Gmail search engine. It will search through all of your emails
for the keyword(s) you type into the search query.

Below to the left where you see the word Gmail is an arrow which directs you to your Google
Contacts and to a Tasks list. More on contacts later. To the right is a menu area and where
to refresh the screen.

To the left of the inbox is what | refer to as the file cabinet. It is a powerful organization tool
by which we will direct incoming messages to store and be filtered. We will be customizing
the file cabinet as well. Below the inbox is an indicator of remaining memory on your
account. Google gives you 15 GB of free storage, shared with Google Drive and Google
Photos. Additional storage can be purchased for as little as $1.99 per month.

Your ultimate mobile office begins here- it's the gear to the right. Click the arrow and select
Settings from the menu:

SRl 11 hittps://mail google.com/mai/tat

- Ap Check = More> B s Forte- X -

v Pagev Safetyv Toolsv b~ @

ravia Search Images Maps Play YouTube News Gmail Documents

Gmail ~ (¢ More 1-40f4 @

box (4)
| Google+ team Create circles to make Google Search even better + ik tter Get start Jun5
Starred

Important Gmail Team Customize Gmail with colors and themes - T x wit ! ¥ the T Jun5
Sent Mail . ,

Gmail Team Import your contacts and old email - ¥ t tact 2 Jun5
Drafts

Gmail Team Get Gmail on your mobile phone Yy y t Jun5
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The General Settings Tab

Settings B -

@ abels Inbox Accounts and Import Filters and Blocked Addresses Forwarding and POP/IMAP Chat Labs Offline Themes

serms smisprep ssegaesgs | —gee sy i e
#| Enable input tools - Use various text input tools to type in the language of your choice - Edit teols - Learn more

# Right-to-left editing support off
Right-to-left editing support on

Phone numbers: Default country code: | United States v

Maximum page size: Show |25 ¥ |conversations per page

Show | 250 v | contacts per page

Images: # Always display external images - Learn more
Ask before displaying external images

Default reply behavior: OfReply |

Leamn more Reply all

Narrow T A T

This is what your body text will lock like

= Conversation view on
Conversation view off

In Settings, the General tab is to the upper left. Here we have the options to:

e Set the Page size- number of messages and contacts per page;

e Images- option to always display images that come with incoming emails
e Set the Default reply behavior when responding to an email

e Set the Default text style- the font, size and color of the text you type

¢ Toggle the Conversation view- emails to be displayed separately or as a continuing thread

Settings = R o

General Labels Inbox Accountsand Import Filters and Blocked Addresses Forwarding and POP/IMAP  Chat Labs Offline Themes

Email via Google+: Who can email you via your Google+ profile? | Circles v

Leam more If people who aren't in your circles send you email this way, you must agree before they can send you more.
Send and Archive: # Show "Send & Archive” button in reply

Leamn more Hide "Send & Archive" button in reply

Undo Send: # Enable Undo Send

Send cancellation period: | 30 ¥ | seconds

Stars: Drag the stars between the lists. The stars will rotate in the order shown below when you click successively. To leam the name of a star for search,
hover your mouse over the image.
Presets 1star 4stars all stars
In use: * ¥ ok I & Kk B

Not in use: @ EH =

Desktop Notifications: « New mail notifications on - Notify me when any new message arrives in my inbox or primary tab
T = Important mail notifications on - Netify me only when an impertant message arrives in my inbox

vnEn newE Mail notifications off
am more
Keyboard shortcuts: # Keyboard shortcuts off
Leam mare Keyboard shortcuts on
Button labels: # lcons
Leam more Text
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o Email via Google+ emails your circles of friends even without their email addresses

e Send and Archive button options to archive an email from the inbox after a reply

¢ Undo Send — enable and set cancellation period up to 30 seconds

e Stars- allows you to highlight messages from the inbox

e Desktop Notifications will popup a new email notifier from anywhere in Google

o Keyboard Shortcuts are handy if you are comfortable using hotkeys and shortcut keys

e Button Labels appear when you select an email. Choose text or icon labels

Settings E - Lo

General Labels Inbox Accounts and Import Filters and Blocked Addresses Forwarding and POP/IMAP Chat Labs Offline Themes

Keyboard shortcuts: ® Keyboard shortcuts off

Leam more Keyboard shortcuts on

Button labels: ® lcons

Leamn more Text

My picture: Change picture @ Visible to everyone
Learn more

Visible only to people | can chat with
If you have a Google Profile picture then it is always visible to everyone.

N -

People Widget:

® Show the people widget - Display information about participants to the right of each conversation
Leamn more

Hide the people widget

Create contacts for auto-

® When | send a message to a new person, add them to Other Contacts so that | can auto-complete to them next time
complete:

I'll add contacts myself

Importance signals for ads: You can view and change your preferences here

¢ My Picture- will be the photo associated with your Google account
¢ People Widget displays a snippet of info about the contact you are emailing
e Create Contacts for auto-complete adds the email address to your contacts list

¢ Importance signals for ads allows you to better customize the types of ads you'll see

Settings B - e
General Labels Inbox Accounts and Import Filters and Blocked Addresses Forwarding and POP/IMAP Chat Labs Offline Themes
Signature: No signature
{appended atthe end of all cuigoing messages ® (G William Ja i
T G. William James <gwj2000@juno.com: v

Sans Serif T B 7 U A co =

TiT
it
il
ll
|
i
I~

#| Insert this signature before quoted text in replies and remeve the " line that precedes it.

Personal level indicators: No indicators

# Show indicators - Display an arrow ( » ) by messages sent to my address (not a mailing list), and a double arrow ( » ) by messages sent only to me.

Snippets: # Show snippets - Show snippets of the message (like Google web searchl)
No snippets - Show subject only.

Vacation responder: # Vacation responder off

= Vacation responder on
First day: January 30, 2015 Last day: |(optional)
Subject:

Message:
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Add Signature Option — will be added to the bottom of new messages

Multiple Signatures- Once you have another account forwarded to your Gmail, you
can send messages out under that address. A great feature is adding a unique
signature for each address. You won't see this feature available until you add another

account. We'll do that next.

Setting Up Mail Forwarding To Your Gmail Account

The following steps are taken from Google Support:

a > N

IS

Open your Gmail account.

At the top right, click the gear *.

Select Settings.

Select the Accounts and Import tab.

In the "Check mail from other accounts (using POP3)" section, click Add a POP3 mail account
you own.

Enter the full email address of the other account, then click Next Step.

Enter your password.

Now you have a few options to choose from. Here’s our recommended settings:

Leave a copy of retrieved messages on the server - Check the box. Otherwise the emails in
your other account will be deleted and you'll only be able to access them in Gmail. Learn more.
Always use a secure connection (SSL) when retrieving mail - Keep checked. For some
accounts, you may need to uncheck this option. Learn more.

Label incoming messages - Check the box if you'd like to easily see which emails in your inbox
came from this account.

Archive incoming messages - Don’t check. Only check if you don’t want to see new messages
from the other account in your inbox.

Click Add Account. If you get an error message while getting set up, click the Show error
details link to find out more about what’s not working.

If you get a message saying that POP is disabled, go to the settings page of your other email
account and look for a way to enable POP.

If you get a message saying that POP is unavailable, your email provider may not support POP.

You can also try other ways to move emails to Gmail.

For other errors, visit our Problems with Mail Fetcher troubleshooter.

Once your account has been added successfully, you'll be asked if you want to be able to send mail
as this address. This lets you compose messages in Gmail, but have them appear to be sent from
your other email account.

Gmail will check your other account for new emails periodically. You can see when the other account
was last checked from the "Accounts and Import" tab.
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https://support.google.com/mail/answer/21289?hl=en
https://support.google.com/mail/answer/21290
https://support.google.com/mail/answer/21291
https://support.google.com/mail/answer/56283
https://support.google.com/mail/troubleshooter/2703752
https://support.google.com/mail/answer/22370
https://support.google.com/mail/answer/22370

My instructions are very similar with a few different suggestions:

Send Mail As- here you can create multiple email identities (alias names) for email to use. If you
receive an email forwarded from your website’s email for example, Gmail can send the reply using
the same address of the original message. Creating a unigue signature for each is possible as well.

Check mail using POP3:- A new feature that will make regular searches of your POP3 email from
other clients, If the client doesn’t allow forwarding, this feature will just sign in as you and download
your mail into Gmail.

Before adding email accounts to be forwarded to Gmail make these two small changes:
Go to Settings > Forward POP and IMAP
In POP Download, select “Enable POP for all mail that arrives from now on”.

In IMAP Access, select “Allow IMAP”. Save the changes at the bottom.

General Labels Inbox Accounts Filters Forwarding and POP/IMAP Chat Web Clips Labs Offline Themes
Forwarding: Add a forwarding address
Learn more b .
Tip: You can also forward only some of your mail by creating a filier!
POP Download: 1. Status: POP is enabled for all mail that has arrived since 10/22/13
Learn more Enable POP for all mail (even mail that's already been downloaded)
* Enable POP for mail that arrives from now on
Disable POP
2. When messages are accessed with POP | keep Gmail's copy in the Inbox v
2. Configure your email client (e.g. Outlook, Eudora, Netscape Mail)
Configuration instructions
IMAP Access: Status: IMAP is enabled
(aceess Gmail from other dients using * Enable IMAP
L) Disable IMAP
Learn more

Return to Settings > Accounts>

Settings
General Labels Inbox Accountsand Import Filters Forwarding and POP/IMAP Chat Web Clips Labs Offline Themes

Change account settings:

Import mail and contacts: Import from Yahoo!, Hotmail, AOL, or other webmail or POP3 accounts
Import mail and contacts

G. wiltiam James[ N
s s i oo ]
. Witiam Jome<
G Witiam James
. Witlam James I
G. William James—

Add another email address you own

: When replying to a message:
Check This Box
@ Reply from the same address the message was sent to

Always reply from default address (currently illiam@pdapowerplus com)

Check mail from other accounts (using

Add a POP3 mail account you own Add email accounts
POP3): . to forward

Select Add a POP3 mail account you own. Enter the email address to forward into the wizard.
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Add a mail account you own Add a mail account you own

Enter the email address of the account to get mail from Enter the mail settings for paimtraining@hotmail.com. Learn more
(Note” You may add 5 more of your accounts)

Email address: palmtraining@heotmail.com

Email address
email address Usemame: [your email address

Password: [sssssses
—
POP Server. |pop3.live.com ¥ | Port:|995 ~
Leave a copy of retrieved message on the server.
Leamn more

& Always use a secure connection (SSL) when refrieving
mail. Learn more
Label incoming messages:

“ (WAL v

¥ Archive incoming messages (Skip the Inbox)

Cancel | | Next Step »

Cd

Cancel | | « Back |  Add Account

Check Leave a copy if you want the original email box to store a copy of the forwarded
email.

Leave Always use a secure connection checked if it is, leave unchecked if it's not.
Check Label incoming messages if you choose to create a folder and automatically store
them, and

Check Archive incoming messages if you want them to go into a folder and not show in
the inbox. Any archived messages not assigned to a label (folder) will be found in ‘All Mail”
on the left.

If the wizard is denied access by your email server, simply go to that email provider (not
Outlook) and by going into settings forward that email to your Gmail address. You will have
to add the account manually to the Alias list as if it were a second Gmail account, using the

steps below.

Once you have completed forwarding a POP3 email address to Gmail, you will then see a
setting “When replying to a Message”. Choose to reply to the same address the email was
sent to, to keep your outgoing messages organized and flowing as you would like. (see
above illustration).

If the email account is not a POP3, but instead an IMAP such as Gmail or AOL, you must
forward these email accounts manually.

Although AOL is IMAP, you must use the POP3 wizard to forward the email to Gmail, using
these settings:
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Email Address; your full address @aol.com
Your AOL password

POP Server is pop.aol.com

Port 995

Check the SSL Box.

To forward a second Gmail account, sign into that account, go to Settings > Forwarding
and POP IMAP. Select “Add a forwarding address”. Enter the Gmail number 1 address
here. Now your second Gmail account will forward to your primary Gmail account along with
your POP3 accounts.

These steps may or may not have to be taken. If you do not see the forwarded email
address listed under “Send Mail As”, then manually add the account to the list with these
steps:

To add this account to your list of email “Alias” names. Follow these steps to add the alias:

Select Settings > Accounts > Add a mail account you own. Add the Gmail address and
click Next Step. Select to use as an alias. When you click Next, Gmail will prompt to send
email through the Gmail server. That will work best for you here. Next, select to send an
email message to the account with a verification code. Copy and paste the code into the
wizard. Your email account has now been verified and ready for use.

& Gmail - Add a mail account you own - 6oogle Chrome -

ttps://mail.google.com

Add a mail account you own

Enter the email address of the account to get mail from
{Note: You may add 5 more of your accounts)

Email address |

| Cancel | | Next Step » |

If the wizard is denied access by your email server, simply go to that email provider (not
Outlook) and by going into settings forward that email to your Gmail address. Now you have
to manually add the account name to the list by selecting Add another email address you
own. Add your name and email address. Select to use as an alias. When you click Next,
Gmail will prompt to send email through the Gmail server. That will work best for you here.
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Next, select to send an email message to the account with a verification code. Copy and
paste the code into the wizard. Your email account has now been verified and ready for use.

Add another email address you own Edit email address
Enter information about your other email address. Confirm verification and add your email address
An email with a confirmation code was sent to GGLUniverse@gmail.com. [Resend emalil]
Name William Blackman To add your email address, do one of the following.
Email address: |sprqalty2013@mail com
] Treat as an alias. Leam more — Click on the link in the confirmation oIR Enter and verify the confirmation code
email Verify
Specify a different "reply-to” address (opticnsl |
[Cancel | [Mext Step » Close window

System labels are the named folders on the left panel. You may choose to hide the folders
you don’t need and only show those you use. Labels and Filters work together to create a
filing and organizing system for email.

Labels are the folders you create and name. Provide a unique name here, or from the main
Gmail screen. Check the box to the left of the message, and open the Labels tab above to
assign it to a labeled folder, which will display on the left panel. Select a folder, place the
mouse pointer over the arrow to the right, and with the left click of the mouse, open the
palette which allows you to color code each folder. You can assign more than one label
(category) to a sender. Scroll down a bit and select subfolder to nest, or assign a sub-
label within a label.

It's easy to move a label into a different folder you have created. Simply select “Edit Label’
and then select the new label for which to nest the folder into.

If you want to no longer see Google’s new tabs for Primary, Promotions and Social mail,
here is where you turn it off: Click the gear in the upper right corner, then select Configure
Inbox. Uncheck the tabs you want to disable.
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Select tabs to enable

v Primary Choose which message categories to show as inbox tabs
Other messages will appear in the Primary tab
v/ Social Deselect all categories to go back to your old inbox

v/ Promotions

Q =
v Updates /

| Forums

Starred messages

v Include starred in Primary

n ki

2 - & G X | M settings - traviaforte@gma... X

Coogle v | 8P scarch - | [ - - | @ Share- B - M- P Bookmarks~ | Ap Check = More>> B eviarorie- X -
B~ B -0 & v Pagew Sefety~ Tools~ @+ @

+Travia Search Images Maps Play YouTube News Gmail Documents Calendar More~

GO. /81&’ “ Travia Forte n share - [l

Gmail ~ Settings e

Gendlll Labels Acunts and Import  Filters Forwarding and POPIMAP  Chat Web Clips Labs Inbox Offline Themes
Syster 8

Show in label list
Drafts

Inbox

» Circles Starred show  hide

Personal Important show hide

Travel Chats show  hide

Less &
Sent Mail show  hide

Chats Drafis show hide show if unread

Al Mail
All Mail show  hide

Spam

Trash Spam show hide show if unread

Receipts Trash show hide

Chat Circles Show in label list Show in message list
Circles show  hide

@ Travia Forte Friends show  hide show hide

- Family show hide show hide g

The update to labels adds your Google+ Circles as an option for people to whom you
communicate via the social networking site.

Filter Tabs

Filters and Labels work closely together. Filters may be assigned to a message from a specific
sender, a specific topic, or assign a label to incoming messages. Set filters from this tab, or check the
box to the left of a message, open the More Actions tab, then select Filter messages like these.

From here you can filter similar messages to come to be directed by way of your filter. You may filter

messages by email address, or keywords. You may also filter messages from Settings > Filters >
Create new filter.
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from:(Jonathan.Banks@msnbc.com)

« back to search options
When a message arrives that matches this search:
¥ Skip the Inbox (Archive ity

Mark as read
Star it

PERSONAL %
< Apply the label:

Forward it add forwarding address
Delete it
MNever send it to Spam

Google Universe 5
#| Send canned response: . &

Always mark it as imporiant
Never mark it as important

. Choose category... =
Categorize as: S

Create filter Also apply filter to 0 matching conversations.

Learn more
Mote: old mail wil not receive a canned response

Records Retention - www AccessSciences com - Let Access Sciences help you build your information management pro About these ads
-

Archive

Spam | Delete * | [= Movetow | Labelsw Marew
Rapportive box | x [Clighes |5

G. William James via gmail.com to show details 5:20 PM (0 minutes ago) | 4 Reply
Rapportive shows you everything about your contacts right inside your
inbox.

You can immediately see what people look like, where they're basad, and
what they do. You can establish rapport by mentioning shared interests,

You can grow your network by connecting on LinkedIn, Twitter,
Facebook and more. And you can record thoughts for later by leaving
notes.

Imagine relationship management built into your email. For free. Sign up
and install Rapportive at http://rapportive.com/install

G. William James | Handheld Computer Selutions

@ G.William James

v

10f9038 4 »

-

Lead Consultant and T

P = vy
Show details
Ads

Secure Record Storage
Document management/Record
Storage Call 770-325-9090 Free
Estimate
www.srstorageonline.com

Web Records Management
Keep records of web content like
wehsites. blogs. news. twitter, etc
www_iterasi.com

DeepProbe
IPDR-generating probes for data

rotoption 2 ncl looaing

Try Boomerang

Another Gmail third-party add on is Boomerang, a service that allows you to schedule when
your emails will be sent from your account. If you type a message on Sunday but don’t want
it sent until Monday at 9am, Boomerang can handle the job. Also get delivery receipts.
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4™ Send Later Dizcard Draft autosaved st 6:43 PM (0 minutes aga)

G William James <wiliam@pdapowerplus.com= w
"GOilliam James" =demohcsgE@gmail com=,

Saidd Co Addd Boo Cansider including: brankinigtds net Gail H

Boomerang Test Mezsage
Attach a file  Inzert: Invitation

Eloomerang thiz meszage | ewen if someans replies w in 2 days

B F U T-T-A-T-Qesj=si=EEM = = Ty 2 FPlain Text
u . . . .
- This Message will not be delivered until 12 hours from now.

The message will "Boomerang” back to me as a reminder in 2 days, even if the recipient replies

Labs

Under the Tab of Labs lies a suite of applications designed for use in Gmail, not by the
developers but by users like you and I. They came up with programs that enhance your user
experience and some are really useful. If there is something you find intriguing simply
enable the tool and then save the change. You can unlike them the same way. There are a
few that have found themselves to be too useful not to become part of the Gmail system.
Take for example in the General tab, where we find “Default text style” and “Undo send”.
They were originally found in Labs, as useful add-ons but proved themselves popular and
useful enough to graduate into Gmail. Other tools here may eventually graduate too, but
there are a couple I find useful enough to share:

Settings

General Labels Inbox Accounts and Import Filters and Blocked Addresses Forwarding and POP/IMAP  Chat Labs Offline Themes]

Save Changes Cancel

Enabled Labs

Canned Responses « Enable

by Chad P i
Refer to documentation e Disable
Status report template Email for the truly lazy. Save and then send your Send feedhack
FAQ common messages using a button next to the compose

form. Also autematically send emails using filters.

Today (Tue, Jul 28) Google Calendar gadget = Enable
by Ben K and Garry B i

9a Dr. Appointment : ) llisahle
1:30p Lunch w friends Adds a box in the left column which shows your Google

Send feedback
4p Pick up Eli at SFO Calendar. See upcoming events, locations, and details.

Google Maps previews in mail = Enable
by Mark K Disable

Shows Goegle Map previews of all the addresses found

: Send feedback
in an email.

O Google Voice Google Voice player in mail # Enable
by Robert D Disable
» 00:01 L]
Lets you _play voicemails Ief_t on your _Google Voice Send feedback
“© Reply =* Forward account right from the email notification.
© Picasa - Photos from this ema| | Picasa previews in mail = Enable
Tia3 3 b Dan Stanlev Mark & |lmech =R
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Canned Responses allow you to create unique autoresponder messages when you
receive messages under certain conditions. Begin with a new message window. Click the
arrow in the lower right of the message to open the menu. Create a hew canned response
by writing the message as a new email, saving it, and then creating a filter that uses the
saved response when prompted by an incoming message.

From William James <william@pdapowerplus.com Cc Bee

Subject

Default to full-screen

Canned responses
Mew canned response.. Label
Plain text mode

Print

Sans Serif - | 4T B 7 U A- = = = = = 9| L& Check spelling
El: a3 B0 -
m 5 n o 2 |
Check the Box “Send canned response” and then choose from the list
from:(no-reply@mail zillow.com) |

« back to search options
When a message arrives that matches this search:
Skip the Inbox (Archive it)
Mark as read
Star it |

¥ Apply the label:  zilow 2 1

Forward it to: Choose an address... add forwarding address

Del
ever send it to Spam

Send canned response: Choose dNgnned response. .

Always mark it as import Webinar
Never mark it as importa Review
Lenncn 2015
KW 2015

new
Update filter Cancel

arm maore
Mote: will not be applied to ok

The filter will respond to the sender with the message written in the chosen response. Try it
a few times and see how useful a tool it can be for your website, social media or marketing.
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Google Voice player in mail adds a playback button to your incoming voicemail messages
from Google Voice. Avoid having to ever call your phone’s voicemail for messages again!

Google Voice <voice-noreply@google.com=

to me |-

Yoicemalil frr::-m:| |at 12:15 AM

Hey William, Good Evening, this is Sherry chest not. |
warrant out was going to talk to you around 8 o'clock. A
couldnt, get my cool working er my things to transfer o

to dinner if you wanna give me a call tomorrow. Th
E. Again, cherries, chess nut |:|ar
They did so much information. I'm the only underwater.
much bye bye.

[+ Google Voice
> 00:51

Chats Tab

Turn on Chats and activate the additional ways to communicate from within Gmail. From
here you may now may calls over the internet, IM chats (instant messaging) or video
conferencing. What you’ll need first for your computer or laptop is the Hangouts Plugin.
You may search Google for that or click here to download the link and install. To
communicate with another PC via video they will need the hangouts plugin as well, so share
with them. To communicate with mobile phones and tablets, they require the Hangouts app,
free at the App Store or Google Play.

Google Hangouts
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https://www.google.com/tools/dlpage/hangoutplugin

Once installed on your computer, look to the left panel below your file cabinet. You will
see a phone, contacts icon and a “quotation” icon to launch Hangouts. Then invite one
to up to nine people to join in! Send a link to begin now or schedule it for later. The link
will bring all invitees to the hangout directly from the link in email. It is great to meet with
a small group of people for a social chat, a business meeting or a consultation. Add
tools like YouTube to share videos with the group, or use the Share Screen feature to
make a presentation or instruct from your computer, and all invitees will see your
screen.

More Secrets of the Advanced User

Gmail offers many conveniences, tricks and useful features that most people never take
advantage of. Try some of these and use Gmail like the pros.

Archive messages after a reply

Once you have replied to an email, take the original out of the inbox (archive it) automatically
with this tool. First, go to Settings > General > Scroll down to Send and Archive:

Send and Archive: » Show "Send & Archive"” button in reply
Learn more Hide "Send & Archive" button in reply

Select to show the button as an option. The next time you reply to a message, you will have
the option to send as before, but now a blue button, an option to archive the message when
you send. The message is not deleted or lost, it remains on the account, just no longer in the
inbox.

Narrow T~ B I U A~ E-i= = E = 9 1
Send A i & $ M e @
Send Later Boomerang this in 2days ¥ if no reply Q

Archive messages after areply

When sending a message to someone not in your contacts, this option will save their email
address to the “Other Contacts” label so the next time you search or send them an emalil
their address will come up to auto-complete. Go to Settings > General > Create contacts for
auto-complete:

Create contacts for auto- When | send a message to a new person, add them to Other Contacts
complete: e I'll add contacts myself
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While this is a convenience many find useful, | personally would rather add them myself, due
to the sheer volume of emails | send to addresses only on rare occasion. Besides, on my
mobile devices, these contacts will appear only as email addresses, and | prefer them to be
filled in with names, etc.

Power Search for Email

Gmail's search engine is more powerful than you might expect. Of course, it uses what | call
the secret sauce of Google, and whatever term you place in the query will produce results it
finds anywhere in your Gmail. account, no matter how long it's been or where it is stored.
One way power users search for messages or a certain type of message is to use Search
Operators. These are special terms which will search your entire account based on the
operator term such as looking for any message that has an attachment would look like this:

Has:attachment.

How about any message that has an attachment 5MB or larger:
Larger:5mb

Or search for messages sent during a certain time period:
After:2014/01/15 before:2014/02/15

This is an awesome tool, and once you practice using the operators a few times, you will
truly be the master of your inbox!

Here is an expanded list of search operators:

What you can search by Search operator & example

Specify the sender From:
Example: from:amy
Specify a recipient To:
Example: to:david
Words in the subject line Subject:
Example: subject:dinner
Messages that match multiple terms ORor{}
Example: from:amy OR from:david

Example: {from:amy from:david}

Remove messages from your results

Example: dinner -movie
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Find messages with words near each
other. Use the number to say how many
words apart the words can be

Messages that have a certain label

Messages that have an attachment

Messages from a mailing list

Attachments with a certain name or file
type

Search for an exact word or phrase

Group multiple search terms together

Messages in any folder, including Spam
and Trash

Search for messages that are marked
as important

Starred, unread, or read messages

AROUND

Example: dinner AROUND 5 friday

Label:

Example: label: friends
Has:attachment

Example: has:attachment
List:

Example: 1ist:infoRexample.com

Filename:
Example: filename:pdf

Example: filename: homework.txt

Example: "dinner and movie tonight"

0)

Example: subject: (dinner movie)

In:anywhere

Example: in:anywhere movie
is:important

label: important

Example: is:important

is:starred
is:unread
is:;read

Example: is:read is:starred
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mailto:list%3Ainfo@example.com
https://support.google.com/mail/answer/186543

Messages that include an icon of a
certain color

Recipients in the cc or bcc field

Search for messages sent during a
certain time period

Search for messages older or newer
than a time period using d (day), m
(month), and y (year)

Chat messages

Messages delivered to a certain email
address

Messages in a certain category

Messages larger than a certain size in
bytes

Messages larger or smaller than a
certain size in bytes

Results that match a word exactly

has:yellow-star
has: blue-info

Example: has:purple-star

cc:

bcc:

Example: cc:david

Note: You can't find messages that you received on bcc.
after:

before:

older:

newer:

Example: after:2004/04/16

Example: before:2004/04/18

older_than
newer_than

Example: newer than:2d

Is:chat

Example: is:chat movie

Deliveredto:

Example: deliveredto:username@gmail .com

Category:

Example: category:updates
Size:

Example: size:1000000
larger:

smaller:

Example: larger:10M

+

Example: +unicorn
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mailto:deliveredto%3Ausername@gmail.com

Messages with a certain message-id Rfc822msgid:

header

Example: r£c822msgid:200503292@example. com
Messages that have or don't have a has:userlabels
label

has:nouserlabels
Example: has:nouserlabels

Note: Labels are only added to a message, and not an entire
conversation.

Gmail Tip: Can | generate mailing labels from my contacts?

Absolutely! In Google Drive, select the Address Labels script from the Template menu. Here
is a link: Gmail Contacts Address Labels

Run the script, select the groups of addresses in your CRM to populate the labels. On the
back of the labels you purchased will be the size and column width of the labels. Complete
this information on the script, place the label pages into the printer, and select print.

The Label template will conform to the label sizes you entered, populate the address
information of each contact that contained an address in that field and what shows on the
screen will be what will print. Try a few pages with paper and match them first to be sure
without wasting expensive labels.

Gmail Tip: Create an Canned Responder for your listing flyers and signs

In Gmail settings, goto Labs, and enable Canned Responses. Make sure to save your changes.
Open to compose a new email, select Canned Responses from the menu.

Write your automated response message, and name the message when you save it.

In Settings, go to Filters, select C reate new filter.

Putin the address of the incoming message (you may want to create a second email account)
and below, check Canned Responses and choose one of your saved messages. Save the filter
settings

The next time that email address comes to your inbox, the chosen canned response message
will be automatically sent to the sender as a reply.

To add an attachment, | used my Evernote account. | produced the information in & note, then
generated a link to the note. Next, | simply added the link to my canned response, so when
clicked will open the information as an Evernote attachment.

Try it- it works!
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Cloud Computing is the way we will communicate, be informed and entertained from now on.
Television networks and print media all understand that if they want to keep us attentive they have to be online,
as this is where we spend our time.

Google TV, Netflix, Hulu, Amazon, Roku, Apple TV and others offer on demand viewing of their content from
anywhere, while the most popular newspapers and magazines don’t rely on us at the newsstand anymore. They
offer us the content on the web.

The computer itself is being replaced by devices with only minimal storage space, and no media drives,
because we all have apps that direct us where we want to be on the Internet. The same goes for our personal
data, as we have discussed in this guide to the Google suite of cloud-based apps. There will be many more to
come, in fact there are other choices out there today; however it is Google that has made it easy for us to
integrate these tools into one useful system, for free, as Facebook has done for social networking.
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Caribbean.
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